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Accessibility Options in Microsoft Windows 7 and Macintosh Snow Leopard  
 

 
System Modifications Windows 7 Macintosh Snow Leopard 

 
Visual Accommodations 
 
Vision problems, ranging from slight 
impairments to blindness, can prevent full 
computer access. System level options 
built into Windows Vista and 7 and Mac 
OS 10.5 Leopard and 10.6 Snow Leopard 
allow for larger fonts, icons, buttons, 
menus and toolbars and speech output. 

  

Change screen resolution. 
Smaller numbers result in larger screen 
objects. 

Control Panel: Appearance & Personalization: Adjust 
screen resolution – 
Choose 800 X 600 for largest screen items. 

OR 
Control Panel: Hardware & Sound: Display: Adjust 
screen resolution – 
Choose 800 X 600 for largest screen items. 

System Preferences: Displays: Display – 
Choose 640 X 480 or 800 X 600 for largest screen items. 

Reduce background clutter by selecting 
a solid desktop pattern. 

Control Panel: Appearance & Personalization: Change 
desktop background: Picture location (Solid Colors) - 
Choose a solid color. 

System Preferences: Desktop & Screen Saver: Desktop – 
Choose one under Apple Images or Solid Colors. 
         Or 
Right-Click (control-Click) on Desktop 
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Change the color of window borders 
and Taskbar/Dock. 

Control Panel: Appearance and Personalization – Change 
window glass colors - 
Select color and transparency intensity. 

OR 
Control Panel: Ease of Access – Optimize visual display - 
Adjust the color and transparency of the window borders. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see – 
Adjust the color and transparency of window borders. 
 
 
Shortcuts to Ease of Access Center: 
Press the Windows logo key on the keyboard. Start typing 
ease in the search bar. Press Enter key. 

OR 
Press the Windows logo key + U. 

Dock is always transparent. See setting Desktop Colors to 
solid colors above. 

Reduce clutter on the desktop by 
minimizing every open window except 
the one you are using. 

Drag (or shake) the title bar back and forth of the window 
you want to keep open (“Shake” feature). 

Click on the Yellow circle on each window to minimize. 

Reduce clutter on desktop by hiding 
icons and gadgets. 

Right-click on empty area of desktop: View – 
Uncheck Show Desktop Icons 
Uncheck Show Desktop Gadgets. 

  

Increase size of icons, labels, and text. 
This can be done in addition to or in lieu 
of changing the resolution. 

Control Panel: Ease of Access: Optimize visual display: 
Change the size of text and icons – 
Select Medium (125%) or Larger (150%) to enlarge text and 
icons on the screen. Alternatively, select Set custom text 
size. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see: Make things on the 
screen larger: Change the size of text and icons – 
Select Medium (125%) or Larger (150%). 

Click on desktop: View Menu: Select Show View 
Options – 
Change icon size/text size/background color. 
 

OR 
Left-Click (Control Click) on the desktop or within a 
Folder- 
Change icon size/text size/background color 
 
 
Inside a Folder you can adjust the Icon size by moving 
the Ball Slider located in the bottom right corner. 
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Make the display monochrome or high 
contrast. 
High contrast color schemes heighten the 
contrast of some text and images on the 
screen making them more distinct and 
easier to identify. 

Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see: Choose a High Contrast 
theme – 
Select a High Contrast Theme (e.g., High Contrast White). 
 
Turn High Contrast on or off by holding down left-ALT + 
left-SHIFT+PRINT SCREEN (or PRTSCRN). 

System Preferences: Universal Access: Display – Choose 
Black on White or White on Black. 
Select Use Grayscale to lose colors. 
 
Adjust Contrast using the Slide Controller or by keyboard. 
 
Control/Option/Command/ Comma = Reduce Contrast 
 
Control/Option/Command/ Period = Increase Contrast 

Add applications to the Start Menu 
and Task Bar (Windows) and Dock 
(Mac). 
Place often used applications and 
documents in these locations for easy 
access. 

By default, Quick Launch Bar is not available in Windows 
7 – 
Drag program icons to the taskbar. 

OR 
Click on the Start Button, locate and right-click on an 
application – 
Select Pin to Taskbar or Pin to Start Menu. 

Drag application icons to the left of the white separator 
line in the Dock. Drag Folders and Document icons to the 
right of the white separator line in the Dock. 

Create a shortcut toolbar on the 
desktop to store programs and files. 

On the desktop, right-click an empty area. Select New, 
Folder. Name the folder. Press Enter key. Drag the folder to 
the very left, right, or top edge of the screen and release it – 
The folder now looks like a toolbar. Drag shortcuts to the 
toolbar. 

 

Make the rectangle around currently 
selected item in dialog boxes thicker. 

Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see: Make things on the 
screen easier to see – 
Make the focus rectangle thicker. 

 

Make the blinking cursor thicker. Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see: Make things on the 
screen easier to see – 
Set the thickness of the blinking cursor (1-20). 

 

Turn off unimportant overlapped 
content and background images. 

Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see: Make things on the 
screen easier to see – 
Remove background images. 
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Increase the size of the Taskbar/Dock. Make sure the Taskbar is unlocked. Point to the edge of the 
Taskbar. When the pointer changes to a double-headed 
arrow, drag the border up or down. 
 
Locking and unlocking the Taskbar: 
Right-click on an empty area on the Taskbar. Check or 
uncheck Lock the Taskbar. 

OR 
Control Panel: Appearance and Personalization: Taskbar 
and Start Menu: Taskbar – 
Check or uncheck Lock the Taskbar. 

Apple Menu: Dock: Dock Preferences – 
Adjust the Dock size and magnification according to user 
preference. 

OR 
 
Click on the Dock size adjuster (the landing strip between 
the Apps and Folders near the right side) and move mouse 
up/down 

Enlarge size of cursor, select pointer 
scheme other than default one. 
Helps a user identify the cursor and track 
it more easily.  

Control Panel: Hardware and Sound: Mouse: Pointers – 
Select larger scheme (e.g., Windows Black Extra Large) 

OR 
Control Panel: Ease of Access: Change how your mouse 
works: Mouse Pointers – 
Change the color & size of mouse pointers. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the mouse easier to use: Mouse pointers. 

System Preferences: Universal Access: Mouse & 
Trackpad – 
The Cursor Size slider adjusts in real time. 
 
System Preferences: Displays: Display – 
Select 640 x 480 or 800 x 600 for largest screen items. 

Adjust cursor blink rate. 
Helps a user identify the cursor location. 

Control Panel: Ease of Access: Change how your 
keyboard works: Keyboard Settings: Speed - 
Adjust Cursor blink rate. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the keyboard easier to use: Keyboard Settings: Speed 
- 
Adjust Cursor blink rate. 
 

 

Change pointer speed, automatically 
move pointer to default button in a 
dialog box, display pointer trails, show 
location of pointer. 
Helps a user identify the location of the 
cursor and track it more easily. 

Control Panel: Hardware and Sound: Mouse: Pointer 
Options –  
Select Pointer Speed. 
Select Snap To. 
Select Display Pointer Trails. 
Select Show location of pointer when I press the CTRL key. 
 

System Preferences: Universal Access: Mouse & 
Trackpad – 
Adjust mouse pointer movement, speed and size using 
sliders. 
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Magnify the screen. 
Magnifier zooms in anywhere on the 
screen and makes everything in that area 
larger. You can move Magnifier around, 
lock it in one place, or resize it. 

Control Panel: Ease of Access: Optimize visual display: 
Turn on Magnifier 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Start Magnifier 

OR 
Start Button: All Programs: Accessories: Ease of Access: 
Magnifier – 
Select view, tracking mode, and zoom level 

OR 
Press Windows logo key on the keyboard: type magnifier in 
the search bar. Press Enter key. 
 

System Preferences: Universal Access: Seeing – 
Turn Zoom on. Use the Zoom Options to customize 
behaviors. 
 
When zoomed in, the screen image can be set to move: 
Continuously with the pointer  
or 
Only when the pointer reaches an edge 
or 
So the pointer is at or near the center of the image 
 

OR 
Press Option-Commmand-8 to turn on. 
 

Use a screen reader. 
Text-to-speech utility that reads text on 
the computer screen, such as the contents 
of the active window, menu options, and 
the text typed into a document. 

Control Panel: Ease of Access: Optimize visual display: 
Turn on Narrator 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Start Narrator 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Use the computer without a display – 
Turn on Narrator 

OR 
Start Button: All Programs: Accessories: Ease of Access: 
Narrator 

OR 
Press Windows logo key on the keyboard: type narrator 
into the search bar. Press Enter key. 
 

System Preferences: Universal Access: Seeing – 
VoiceOver can be turned off/on using keyboard. Use the 
VoiceOver Utility to customize behaviors. 

OR 
Press Command-fn-F5 

Use auditory cues when certain locking 
keys are pressed (e.g., Caps Lock) 

Control Panel: Ease of Access: Change how your 
keyboard works -Turn on Toggle Keys 

OR 
Turn Toggle Keys on or off by holding down NUMLOCK 
for five seconds. 
 

System Preferences: Universal Access: Seeing: 
VoiceOver Utility: Verbosity: Announcements 
 
Announce when a modifier key is pressed.  
Announce when the caps lock key is pressed. 
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Hear descriptions of what’s happening 
in videos 

Control Panel: Ease of Access: Optimize visual display – 
Turn on Audio Description. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Use the computer without a display – 
Turn on Audio Description. 

QuickTime Player supports Open Audio Description 
video if available. 

Turn off unnecessary animations Control Panel: Ease of Access: Ease of Access Center: 
Use the computer without a display – 
Turn off all unnecessary animations (when possible).  
Designate how long Windows notification dialog boxes 
should stay open. 

OR 
Control Panel: Ease of Access: Optimize visual display – 
Turn off all unnecessary animations (when possible). 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make it easier to focus on tasks – 
Turn off all unnecessary animations (when possible). 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the computer easier to see – 
Turn off all unnecessary animations (when possible). 

 

Use audio compression within 
QuickTime Player. 
Listening to recorded speech can be 
tedious if there are long pauses between 
the speaker(s) words or phrases. Speech 
that has been recorded using GarageBand, 
iMovie or audio recorders can be played 
back without pauses or pitch change. 

 Using QuickTime Player, click  the Fast Forward (>>) 
button once or twice to speed up audio speech. 

 
Hearing Accommodations 
 
Provides visual prompts to audio alerts 
for students with hearing impairments 
and attention problems.  
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Use visual cues when an alert sound 
occurs. 

Control Panel: Ease of Access: Replace sounds with visual 
cues – 
Turn on visual notifications for sounds (Sound Sentry) – 
Choose visual warning.  

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Use text or visual alternatives for sounds – 
Turn on visual notifications for sounds (Sound Sentry). 

System Preferences: Universal Access: Hearing – 
Select Flash the screen when an alert sound occurs. 

Turn on text captions for spoken 
dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
Play Stereo audio as Mono- 
Converts all stereo audio to monaural for 
users with unilateral hearing loss. 

Control Panel: Ease of Access: Replace sounds with visual 
cues –  
Turn on text captions for spoken dialog (when available). 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Use text or visual alternatives for sounds – 
Turn on text captions for spoken dialog (when available). 

Be sure you have at least QuickTime v. 7.4. Videos from 
the iTunes store with Closed Captions will be identified 
with “CC”. Users can now do ‘Power Searches’ to isolate 
movies with Closed Captions only. When in the QT 
Player, go to the View menu and select ‘Show Closed 
Captioning’.  
Play stereo audio as mono- Converts to monaural for 
users with unilateral hearing loss. 
 
 
 
 
 
 
System Preferences:Universal Access:Hearing- Select 
‘Play stereo audio as mono’ 
 

 
Physical Accommodations 
 
Customizing the system makes it easier 
for a student with physical disabilities to 
control a computer. 
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Control the computer with one finger. 
Allows computer access with one finger, 
headstick, or mouthstick. 

Control Panel: Ease of Access: Change how your 
keyboard works: Turn on Sticky Keys – 
Select Set up Sticky Keys to customize this feature.  
 OR  
Control Panel: Ease of Access: Ease of Access Center: 
Make the keyboard easier to use: Turn on Sticky Keys – 
Select Set up Sticky Keys to customize this feature. 

System Preferences: Universal Access: Keyboard – 
Select Sticky Keys. Display pressed keys on screen. 
 OR  
Press the Shift Key 5 times. If activated in System 
Preferences: Universal Access: Keyboard – 
 

Slow down key acceptance. 
Creates a delay between when a key is 
pressed and when it is accepted. 

Control Panel: Ease of Access: Change how your 
keyboard works: Turn on Filter Keys – 
Select Set up Filter Keys. Select Set up Repeat Keys and 
Slow Keys to adjust the timing. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the keyboard easier to use: Turn on Filter Keys – 
Select Set Up Filter Keys. Select Set up Repeat Keys and 
Slow Keys to adjust the timing. 

OR 
Turn Filter Keys on or off by holding down the right SHIFT 
key for eight or more seconds. 

System Preferences: Universal Access: Select Slow Keys 
On, use Acceptance Delay slider. 
 

Highlight and drag without holding 
down the mouse button. 
Allows users who have difficulty holding 
down a mouse button to highlight and 
drag to use a standard mouse. 

Control Panel: Hardware & Sound: Mouse: Buttons: 
Turn on ClickLock  - 
Select Settings to adjust the timing. 

OR 
Control Panel: Ease of Access: Change how your mouse 
works: Mouse Settings: Turn on ClickLock. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the mouse easier to use: Mouse Settings: Turn on 
ClickLock. 

System Preferences: Trackpad  
Select Trackpad Gestures: On Clicking: On 
Dragging: On 
Drag Lock: On 
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Turn off Key Repeat. Control Panel: Ease of Access: Change how your 
keyboard works: Turn on Filter Keys: Set Up Filter Keys - 
Select Set up Repeat Keys and Slow Keys. Select Ignore all 
repeated keystrokes. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the keyboard 
easier to use: Turn on Filter Keys: Set up Filter Keys –  
Select Set up Repeat Keys and Slow Keys. Select Ignore all 
repeated keystrokes. 

System Preferences: Keyboard /Key Repeat Rate –  
Adjust with slider. 

Create keyboard shortcuts. Press and hold down CTRL + SHIFT when dragging a file 
to the desktop or a folder. 
AND 
My Computer or Desktop: Right-click on program file or 
shortcut: Properties: Shortcut – 
Type a Shortcut key.  

System Preferences:  
Keyboard : Keyboard Shortcuts  
Use the + to add new shortcuts. 

Emphasize keyboard shortcuts on the 
screen. 

Control Panel: Ease of Access: Ease of Access Center: 
Make the keyboard easier to use – 
Select Underline keyboard shortcuts and access keys. 

OR 
Control Panel: Ease of Access: Change how your 
keyboard works – 
Select Underline keyboard shortcuts and access keys. 

Keyboard Shortcuts always appear next to menu item 
when available. 

Allow for full keyboard access. Windows has shortcuts that allow for full keyboard access. 
See Help section for list of keyboard shortcuts. 

System Preferences:  
Keyboard: Keyboard Shortcuts  
Select Text boxes and lists or All controls. 

Navigate the computer using the 
keyboard. 

Press Windows logo key on keyboard. Start typing the name 
of the program. Press Enter when it appears in the search 
results. 
 
Select and open applications by typing letters, using arrow 
keys and keyboard shortcuts. 

Select Command-Space to bring up Spotlight. Type the 
first few letters of any application, document, or text 
within a document. Found items are organized by type. 
Applications are listed first. Use the arrow keys to move. 
Press Return to select. 

OR 
In the finder, type the first few letters of the program. 
Press Command – “O” when it highlights. Note – “TAB” 
will select the next item alphabetically. “SHIFT-TAB” 
will select the previous item alphabetically. 
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Use the keyboard to move mouse 
cursor. 
If the user is proficient with one digit or 
stick, he can mouse around. 

Control Panel: Ease of Access: Change how your 
keyboard works: Turn on MouseKeys – 
Select Set up MouseKeys. 
Select Pointer Speed Options. 
Num Lock may need to be turned on for MouseKeys to 
operate properly. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the mouse easier to use: Turn on MouseKeys. 
 
Turn Mousekeys on or off by holding down left-ALT + left-
SHIFT + NUMLOCK. 

System Preferences: Universal Access: Mouse & 
Trackpad – 
Turn MouseKeys ON. Control speed with Delay and 
Speed sliders. Num Lock may need to be turned on for 
MouseKeys to operate properly on keyboards without 
numeric keypads. 3rd party external keypads can be used. 

OR 
System Preferences: Universal Access: Mouse & 
Trackpad – 
Activate “Press the Option Key 5 Times to turn Mouse 
Keys on or off” 
Press Option Key 5 times. 
 

Slow down the mouse double-click. 
Assists users who have difficulty double-
clicking. 

Control Panel: Hardware and Sound: Mouse: Buttons – 
 Double-click speed. Adjust speed on slider. 

OR 
Control Panel: Ease of Access: Change how your mouse 
works: Mouse Settings: Buttons –  
Double-click speed. 
Adjust speed on slider. 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Make the mouse easier to use: Mouse Settings: Buttons – 
Double-click speed. Adjust speed on slider. 

System Preferences: Mouse or  Trackpad– 
Set Double Click Speed with slider. 

Set scroll bar behavior. 
It is often easier for users to have scroll 
arrows next to each other for easy access. 

 System Preferences: Appearance – 
Place scroll arrows Together. You can also set the scroll 
click behavior. 
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Use an on-screen keyboard. Control Panel: Ease of Access: Ease of Access Center: 
Start On-Screen Keyboard. 

OR 
Start Button: All Programs: Accessories: Ease of Access: 
On-Screen Keyboard. 

OR 
Press the Windows Logo key on the keyboard: Type 
keyboard in the search bar. Press Enter key. 
 
7’s on-screen keyboard is movable and resizable. 

System Preferences: Keyboard: 
Check ‘Show Keyboard & Character Viewer’, select 
‘Show Keyboard Viewer’ on the menu bar to the right of 
the day & time. The keyboard is now moveable, re-
sizeable and compatible with Sticky Keys. 
  

Use a different keyboard layout. 
Some users may prefer a Dvorak or Left 
or Right Hand Dvorak. 

Control Panel: Clock, Language, & Region: Change 
keyboards or other input methods: Keyboard and 
Languages: Change Keyboards – 
Click Add. Scroll down to English. Select Keyboard (e.g., 
US Dvorak, US Dvorak for left hand, US Dvorak for right 
hand). 

System Preferences: Language & Text: Input Sources – 
Select Keyboard, (e.g., US Dvorak, US Dvorak for left 
hand, US Dvorak for right hand). select it again from the 
Keyboard menu, located to the right of the Day and Time. 

Use an inexpensive graphics tablet and 
Ink or a Tablet PC. 
Students with severe physical disabilities, 
such as muscular dystrophy and spinal 
muscular atrophy, can often form letters, 
but are unable to move their hands across 
the paper. These students can conserve 
energy by writing in one place. 

Control Panel: Hardware and Sound: Tablet PC Settings – 
Handwriting recognition is available in Windows 7. Many 
settings are appropriate only for a Tablet PC. Automatic 
learning of handwriting (i.e., handwriting personalization) is 
available only on a Tablet PC. 

OR 
Start Button: All Programs: Accessories: Tablet PC – 
• Personalize Handwriting Recognition (Target specific 

recognition errors, teach the recognizer your 
handwriting style) 

• Tablet PC Input Panel 

• Windows Journal 

To make the Tablet PC Input Panel appear on the taskbar, 
right-click on the taskbar, select Toolbars, select Tablet PC 
Input Panel. 

Note: The Tablet PC task window appears on the right side 
of the screen by default. 

OR 
Press Windows logo key on keyboard. Start typing tablet in 
the search bar. Press Enter key. 

System Preferences: Ink – 
Gestures are used to perform space, tab, delete, etc. Text 
can be copied from “Ink” window or select ‘write 
anywhere’ to enter text directly into applications.  
 
Note: Ink will only appear if a graphics tablet is 
connected. 
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Speech Recognition 
Control the computer using your voice. 
Open, close, control, and switch among 
applications and navigate menus.  

Control Panel: Ease of Access: Speech Recognition 
Options – 
Start speech recognition. Set up a microphone. 

OR 
Start Button: All Programs: Accessories: Ease of Access: 
Windows Speech Recognition. 

OR 
Press Windows logo key on keyboard. Start typing speech 
into the search bar. Press Enter key. 
 
Speech recognition in Windows 7 allows users to dictate 
documents and emails in mainstream applications, as well as 
complete forms on the Web.  

System Preferences: Speech: Speech Recognition – 
Set your Microphone and Listening Method. Select 
‘Calibrate’ to improve recognition and/or view over 70 
eligible spoken system commands including ‘move page 
down/up’ to scroll through long web pages using voice. 

Connect assistive devices e.g., 
Alternative and  Augmentative 
Communication (AAC) device. Allows 
alternative access to keyboard and mouse 
features. 

Windows 7 does not include this feature. System Preferences: Universal Access: Mouse & 
Trackpad – 
Check ‘Enable access for assistive devices.’ 

 
Accommodations  

for Learning 
Some users with learning differences 
need extra support to complete computer 
and school tasks. Windows and Mac 
operating systems have built-in features 
that help users read, look up definitions, 
and use a calculator for math and data 
conversions. 

  

Use colored labels to differentiate 
documents and folders. 
Change the label color of any icon. 
 
 
 
 

 Select the label icon with one click: Under File, select Get 
Info: Click on expansion triangle next to General if 
closed. 

OR 
Right-click/Control-click on a label and choose Select one 
of 8 colors. 
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Add a picture to a folder, change the 
standard folder icon to another icon. 
Some users can better identify the 
contents of folders if pictures or icons 
other than the default folder symbol is 
used. 
 
 
 
 
 
Use Cover Flow and Top Sites to allow 
struggling readers to locate folders, 
documents and Internet sites through 
images  
 

Right-click on folder: Properties: Customize: Folder 
pictures – 
Choose a file to show on this folder icon. 
or 
Folder icons – Choose icon. 

Copy an image: Select the folder or file of the icon you 
want to replace: File Menu, Get Info (or press Command-
I) to open the Info window. Click the icon in the upper-
left corner of the Info window to select it: Press 
Command-V to paste.  
 
 
 
 
‘Cover Flow’ can be selected from the View menu while 
in the Finder. Replace all generic icons with 
representational graphics/photos. 
 ‘Top Sites’ is a Safari web browsing optional view that is 
located under the Right Arrow in the upper left corner. Its 
icon is a 3x4 matrix of small squares. 

Preview the contents of open windows 
without clicking away from the window 
you are currently working on. 

Point to a program button on the taskbar that has open files. 
Point to a thumbnail of one of the files. (All other open 
windows fade away to reveal the selected window.) To 
restore the desktop, move the pointer away from the 
thumbnails (‘Peak’ feature). 

 

Prevent windows from being 
automatically arranged when moved to 
the edge of the screen. 
Automatic arrangement of windows can 
be distracting for some users. This feature 
can be disabled. 

Control Panel: Ease of Access: Ease of Access Center: 
Make it easier to focus on tasks – 
Prevent windows from being automatically arranged when 
moved to the edge of the screen. 
 
Windows 7 includes the Aero Snap feature, which allows 
users to snap or fix windows to the edges of the computer 
screen by dragging them to the edges and dropping them. A 
window is maximized when moved to the top edge of the 
screen and tiled when moved to either the left or right of the 
screen. 
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Set up the computer to read text. 
Text-to-speech (TTS) is the ability of the 
operating system to read printed text as 
spoken words. Users are able to select 
words, phrases, or whole texts to read 
aloud. 

Control Panel: Ease of Access: Optimize visual display: 
Turn on Narrator 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Start Narrator 

OR 
Control Panel: Ease of Access: Ease of Access Center: 
Use the computer without a display – 
Turn on Narrator 

OR 
Start Button: All Programs: Accessories: Ease of Access: 
Narrator 

OR 
Press Windows logo key on the keyboard. Start typing 
narrator into the search bar. Press Enter key. 
 
Narrator reads text on the screen and describes the desktop and 
open windows. It will also read aloud what a user types and 
announce events that happen on the screen (e.g., dialog boxes). In 
addition, Narrator allows the user to adjust the speed, volume, or 
pitch of the voice. However, this Windows accessibility program 
provides only basic functionality. 
 
Additional text-to-speech engines are available from other 
manufacturers. Typed, downloaded, or scanned text can be read by 
commercial scan and read programs. 

System Preferences: Speech:Text to Speech-  
Select your System Voice & Rate. Select Speak Selected 
Text when the key is pressed. You can re-set the HOT key 
that triggers the speech.  
 

OR 
For a more complete systems wide Screen Reader 

experience: 
 
System Preferences: Universal Access: Seeing: 
VoiceOver On 
 
 
 
 
Create iTunes, and CD audio files from iWork, Mail, 
TextEdit, Safari web sites or other Cocoa Apps. 
 
Students, teachers and administrators can convert any text from 
most every Cocoa App into a text-to-speech file in 3 steps.  
(1) Select text to be converted (2) From the ‘Services’ Menu 
select ‘Add to iTunes as a Spoken Track’. You can use a short-
cut by Control-Clicking or Clicking with 2 fingers on the track-
pad or Right-Clicking on the selected text and selecting ‘Add to 
iTunes as a Spoken Track’ from the contextual menu. (3) Wait 
for the audio cue and re-name the recording when iTunes 
appears. 

Use the dictionary shortcut in 
TextEdit, Safari, Pages, or other 
Applications written in Cocoa. 

 Users can bring up definitions using Hot keys. Hold 
Control- Command & ‘D’ key to view definitions. The 
dictionary can also be brought up as an application or 
widget. 

Use the word completion shortcut in 
TextEdit, Safari, Pages, or other 
Applications written in Cocoa. 

 Press the Escape key to view a list of all possible word 
completions. 
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Use the Calculator for math and 
conversions. 

Start Button: All Programs: Accessories – 
Select Calculator. 

OR 
Press Windows logo key on the keyboard. Begin typing 
calculator in the search bar. Press Enter key. 
 
You can use the Calculator in Standard mode to do simple 
calculations, or in Scientific, Programmer, or Statistic 
modes to do advanced calculations. A number of additional 
options are available, including unit conversion, date 
calculation, and worksheets for calculating a mortgage, 
vehicle lease, and fuel economy (mpg or L/100m). 

Hard drive:Applications: Calculator 
OR 

Use Spotlight (Command-Space) and type ‘calc’  
OR 

 Enter a math problem in Spotlight. (i.e.- 34 * 55=) 
Drag it to the Dock for easy access. 
 
You can use the Calculator in Standard mode to do simple 
calculations, or in Scientific or Programmer modes to do 
advanced calculations.  
 
 It can be set to Speak the Button Pressed or Speak and 
Print the Result.  
 
It can convert Area, Currency, Energy or Work, Length, 
Power, Pressure, Speed, Time, Temperature or Volume, 
Weights and Masses. 
 

Limit access to specific programs. 
You can set up restrictions for how users 
access computer resources, such as 
allowing users to operate computers and 
save documents, but not install programs 
or change system settings,  limiting 
access to specific programs, restricting 
printing capabilities, etc. 

Control Panel: User Accounts: Give other users access to 
this computer – 
Click Add. 
Type user name and domain. 
 
Select Standard User when asked about level of access. 
 
Windows 7 provides two main types of user accounts (for general 
users) and administrator accounts (for designated administrators). 
Standard account users can use (but not install) most software and 
change system settings that do not affect other users. There are a 
number of common, low-risk tasks that standard account users can 
perform, and these can be restricted by an administrator. 
Administrators can also limit access to specific programs through 
Group Policy. 
 
Parental controls are built into 7. These controls are designed to 
help parents manage what their children can do on the computer. 
Parents can decide which software programs their children can use 
and which websites they can visit. Parents can also determine the 
specific times of the day the computer can be used.  
To configure the Parental Control Panel: 
Control Panel: User Accounts and Family Safety: Set up parental 
controls for any user. 
 

System Preferences: Accounts  
Create a new account by clicking the lock to make 
changes, then the ‘+’ key to add new users. 
Select ‘Managed with Parental Controls’ under New 
Account. Select Create Account. Check Enable Parent 
Controls, then select Open Parental Controls. 
 
Time limits and specific usage times can be set. 
Applications can be enabled or disabled. Email and 
instant messaging exchanges can be restricted to specific 
accounts. Websites can be restricted and profanity can be 
hidden in the built-in dictionary. Logs can be collected on 
websites visited, blocked sites attempted, applications 
used and all internet chats. 
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Have the most used applications pre-
loaded at boot-up. 
Any application can open automatically 
upon startup, eliminating the need for 
users to open frequently-used programs. 
 

Log in as an administrator. Right-click on the exe file you 
want to run at startup, or a file to open at startup, and 
click Create Shortcut. 
Start Button: All Programs: Right-click on Startup folder. 
Click on Open All Users or Explore All Users. Drag the 
shortcut inside the startup folder and drop it. 
 
For individual students: Log in as an administrator, set up 
the student’s profile, then drag the applications into the 
student’s startup folder. 

Login as the User you want to set up. Be sure User has 
administrative permission, even if temporary.  
 
Place the applications you want to pre-load in the dock. 
Select each application from the Dock. Select Open at 
Login from the ‘Options’ pop-up menu. 

OR 
System Preferences: Accounts  
Be sure user has administrative permission. Select Login 
Items, select the ‘+’ to add the application you want to 
pre-load when the user logs in. 
 

Use iChat to communicate with others 
in Sign Language 
 
 

 Open iChat, enter your AIM, mac.com or MobileMe 
account name. AIM (AOL Instant Messenger) accounts 
are free. Add the other User to your buddy, family or co-
worker list. Initiate your video chat by clicking on the 
camera icon next to the User’s name. You can 
videoconference with PC users if they have AOL Instant 
Messenger (AIM) 6.1 or higher. ‘Skype’, ‘SightSpeed’ or 
other cross-platform applications could also be used. 
 

Use QuickTime Player & built-in Mic 
and/or Camera 
 
Students can record homework/ 
reports/tests as audio. 

OR 
 
Archive your student’s reading 
fluency/articulation as audio/video files 
without buying extra software. 

 Open QuickTime Player – 
Select ‘New Audio Recording’ or ‘New Movie 
Recording’ from the File menu.  
 
For even more fun have students record video reports 
using free Mac software. Open ‘Photo Booth’, press the 
right ‘Effects’ arrow three times to get to the ‘User 
Backdrops’. Drag and drop digital stills or videos clips of 
your own or from the Internet to provide a relevant static 
or video backdrop for the student’s report. 
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Use QuickTime Player with Free 
Screen Recorder to: 
 
Archive your student’s 
technology/educational skills by 
recording their computer screen 
actions w/without audio. 

OR 
 
Create your own video lessons for 
playback on computer. 
 

 Open QuickTime Player- Select ‘New Screen Recording’ 
from the File menu. Options for- Audio source, Video 
quality and ‘Save to’ can be found under the triangle in 
the lower right of the ‘Screen Recording Window’ After 
recording you will have the option to trim the beginning/   
end of your video and the ability to export to your 
MobileMe Gallery, YouTube or iTunes for iPod/iPhone 
or CD playback. 

Provide automatic Abbreviation-
Expansion  
System Wide, using the Text 
substitution/Auto-correct feature found 
in TextEdit and other aware 
applications written with Cocoa.  

 System Preferences:Language & Text- Select the Text 
tab. Click the ‘+’ sign in the lower left to add.  
Users can develop their own abbreviated codes and/or 
enter appropriate Internet acronyms to make typing faster 
and conserve keystrokes. 
 

 


